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Résumé  

L’arrivée de l’imagerie satellite à THRS ouvre de nouvelles applications en télédétection dans le 

domaine de l’écologie. Malgré les nombreux avantages de l’approche orientée objets pour le 

traitement de l’image à THRS pour une thématique écologique. L’objectif de ce travail est 

trouver une meilleure classification pour l’extraction des objets terrestres à partir d’une image 

Landsat-8 OLI (30 m de résolution). L’étude porte sur une unité topographique d’une utilisation 

écologique variée, soit un des bassins versant de la région nord-ouest de l’Algerie (bassin 

versant de l’oued Kramis). Les tests de classification sont effectués d’une part, par les méthodes 

dirigées et non dirigées au moyen du logiciel l’ENVI 4.7 et d’autre part par la méthode orientée 

objet au moyen du logiciel eCognition. Conformément aux utilisations de notre zone cette 

dernière méthode semble avoir une similitude très proche à la réalité du terrain. Les résultats 

obtenus de six classes d’occupation par la classification orientée objet, plan d’eau, 

céréaliculture, forêt, calcaire, sol nu et la jachère donnent respectivement les taux 

suivants : 0,5%, 20,5%, 5,2 %, 0,4%, 61,2  et 12,3%. Afin d’améliorer la classification des 

arbres dispersés et des petites rues, nous recommandons d’utiliser des données d’altitude ou de 

plus haute résolution spectrale ainsi que des méthodes de traitement d’images plus adaptées. 

Mot clés : Bassin versant, Oued Kramis, ENVI 4.7 ,eCognition  

 

 الملخص:   

 من الرغم على. البيئة مجال في بعد عن الاستشعار في الجديدة التطبيقات يفتح THRS في الصناعية الأقمار صور وصول

 على العثور هو العمل هذا من والهدف. إيكولوجي لموضوع THRS في الصور لمعالجةالموجه للتصنيف  العديدة المزايا

وحدة  على الدراسة وتركز(. قرار م 30) 8-لاندسات OLI صورة من يةالأرض الاجسام لاستخراج أفضل تصنيف

 فيالمائي  حوض) الجزائر من الغربية الشمالية المنطقة فيالمائي  حوض من واحدة المتنوع، البيئي للاستخدامطبوغرافية 

 ENVI باستخدام والإشراف للرقابة خاضعة غير أساليب خلال من مرة، لأول التصنيف اختبارات تتم(. Kramis وادي

 كمامنطقتنا،  لاستخدامات وفقا  . eCognition برنامج باستخدامالموجه التصنيف  طريقة خلال من والآخر 4.7 البرمجيات

سطح الموجه، بالتصنيف  فصول ستة المحصل عليها في نتائجال. الواقع حقيقة كبير حد إلى تشبه الأخيرة الطريقة هذه أن يبدو

٪  5.2 ،٪20.5 ،٪0.5: التالية النسب التوالي على البور والارض العارية والتربة الكلس، والحجر والغابات، والحبوب الماء،

 دقة أو المرتفعة بيانات باستخدام ونحث صغيرة، وشوارعمتنوعة  أشجار تصنيف تحسين أجلومن ٪. 12.3و 61.2و٪ 0.4و

 .ملائمة كثرالأ الصور معالجة وطرق على للطيفأ

 eCognition، برنامج   ENVI 4.7واد كراميس ، المائي،الحوض الكلمات المفتاحية: 

 

      .                                                                                                                                     



Abstract :  

The arrival of satellite imagery at THRS opens up new applications in remote sensing in the 

field of ecology. Despite the many advantages of the object-oriented approach for image 

processing at THRS for an ecological theme. The objective of this work is to find a better 

classification for the extraction of terrestrial objects from a Landsat-8 OLI image (30 m 

resolution). The study concerns a topographic unit of varied ecological use, one of the 

watersheds of the northwestern region of Algeria (watershed of wadi Kramis). The classification 

tests are carried out on the one hand by the directed and non-directed methods using the ENVI 

4.7 software and on the other hand by the object-oriented method using the eCognition software. 

In accordance with the uses of our zone this last method seems to have a similarity very close to 

the reality of the field. The results obtained from six occupancy classes by object-oriented 

classification, body of water, cereals, forest, limestone, bare soil and fallow respectively give 

the following rates: 0.5%, 20.5%, 5.2 %, 0.4%, 61.2 and 12.3%. In order to improve the 

classification of scattered trees and small streets, we recommend using altitude or higher 

spectral resolution data as well as more suitable image processing methods. 

Key words: Watershed, Oued Kramis, l’ENVI 4.7 , eCognition . 
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Introduction   

1 

Introduction : 

L’occupation des terres est une variable fondamentale pour la planification régionale 

ainsi que pour l’étude et la compréhension de l’environnement (Foody, 2002). Cependant, 

l’apparition de l’imagerie satellite à très haute résolution spatiale (THRS), issue de Ikonos 

(Bhaskaran et al., 2010), World View-2 (Jia et al., 2013), Spot-5 (Achbun et al., 2013 ; 

Kassouk et al., 2014) ou Quick bird (Pham et He, 2015), ouvre de nouvelles applications 

en télédétection permettant en effet, la mise à jour des bases de données spatiales d’une 

région donnée.  

La terre émergée est extrêmement hétérogène tant au niveau spatial qu’au niveau 

spectral. La complexité spatiale se manifeste par la densité et la diversité des objets qui s’y 

trouvent. La résolution spectrale, à l’intérieur d’une classe d’occupation du sol, augmente 

quand la taille de pixel est réduite, comme dans le cas des capteurs à THRS (Pham et He, 

2015). La classification par pixels n’est pas capable de séparer les classes d’occupation des 

sols. Cela confirme que l’information spectrale à elle seule, y compris celle obtenue avec 

des images THRS, est insuffisante pour distinguer les objets terrestres (Guindon, 1997). De 

nouvelles études se sont donc penchées sur une autre approche appelée « orientée objet », 

qui intègre d’autres types d’informations que les signaux spectraux, ainsi elle est basée sur 

la création d’objets d’image (Hay et Castilla, 2006). Plusieurs auteurs montrent que cette 

approche donne de meilleures cartographies géomorphologiques (Jia et al., 2013), 

géologiques ou lithologique (Kassouk et al., 2014 ; Hereher et Shehta, 2017) ainsi que 

celles de l’utilisation des terres (Bhaskaranet al., 2010 ; Achbun et al., 2013). 

Pour cela le présent travail est structuré comme suit : 

 Etude des caractères physiques du milieu. 

 Synthèse bibliographique consacré à la présentation de la télédétection, 

le couvert végétal et les classifications de l’occupation du sol.   

 Le troisième chapitre décrit le matériel et les méthodes 

 Le quatrième chapitre exposera les résultats et la discussion  

Enfin, nous terminerons par une conclusion générale où seront résumées les grandes lignes 

de ce travail. 
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2.1. Présentation de la région d’étude  

2.1.1. Localisation de la région d’étude  

Le bassin versant de l’Oued Kramis se situe dans la partie Nord-Ouest de l’Algérie. Les 

limites géographiques du bassin versant ainsi définie sont entre 36° 16' 44'' et 36° 6' 12" 

latitude Nord, ainsi qu’entre 0° 56' 42"et 0° 39' 18" longitude Est (Projection WGS84, 

Zone 31 hémisphère Nord). 

Il occupe une superficie totale d’environ 304.3 km². Il fait partie du grand bassin versant 

de Côtiers algérois. L’Oued Kramis prend sa source dans les monts de Taougrite et la 

partie amont de la commune de Sidi Mhamed Benali à l’Est. 

 

Figure 1 : Localisation de la zone d’étude 

Le barrage d’eau de l’Oued Kramis a été mis en service en 2004 pour une capacité de 

rétention 45 millions m
3
. Ce dernier doit répondre aux besoins d'approvisionnement en eau 

potable à une population rurale totale de 11 546 habitants appartient aux communes situées 

au sein et au autour du bassin versant à savoir les communes: Sidi Mhamed Benali, 

Mediouma, Dahra, Nekmaria, Achaacha,Khadra, Beni Zentis, El Guettar, Mazouna, Ain 

Marane et Taougrite et des besoins agricoles par le développement de l'irrigation sur le 

périmètre de Achaacha d’une surface de 4300 hectares situé à l’aval de la zone d’étude. 
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2.1.2. Géologie de la zone d’étude 

L’information géologique a été prise de la carte géologique à  l’échelle  1/500 000 de 

l’Oued Okris et de l’étude réalisée par (Caltechnika, 1975) portant sur le reboisement 

industriel. 

Le rapport géologique consulté indique que les formations rocheuses présentes dans la 

région sont composées de grés carbonatées en surface, d’argile, de calcaire et de marnes en 

profondeur. La vallée du bassin versant du barrage Kramis est formée par des bancs de 

sable fin à moyens limoneux. 

Des alluvions sableuses sont présentes dans le lit d’Oued et des dunes à l’embouchure. 

La carte géologique consultée indique que la zone d’étude est recouverte de roches 

sédimentaires, plutoniques. 

La carte géologique consultée distingue plusieurs types de dépôts quaternaires alluvions 

(actuelles, récentes, anciennes), les colluvions, les éboulis, les dunes ainsi que les sable.   

2.1.3. Types de sol 

L’information pédologique a été prise de l’étude (BNEDER, 1998) relativement au 

schéma agricole de la wilaya de Mostaganem. 

L’influence négative du relief qui est accidenté et parfois largement ondulé a conféré 

aux sols de la zone le caractère de discontinuité. 

En effet, il s’agit d’une succussion ou d’un ensemble de sols, ils comprennent 

essentiellement des sols érodés (Lithosols, Régosols) et des sols calcimorphes surtout les 

rendzines, les sols à sesquioxyde de fer à l’état parfois érodé qui se développent sur  

matériaux gréseux par endroit, ces unités se caractérisent par affleurements rocheux. 

En dehors des sols longeant l’Oued Kramis et les principaux affluents et qui sot 

alluviaux, le reste du périmètre est représenté par des sols à possibilité agricole très limitée 

(forte pente), de même leur situation topographique les expose fréquemment aux 

problèmes d’érosion pluviale (ravinement intense, ruissellement diffus et concentre) qui se 

traduit par un décapage des horizons de surface favorisé en cela par une couverture 

végétale pratiquement inexistante. 
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2.1.3.1. Sols bruts 

 Lithosols : ce sont des sols reposants sur des roches dures ne permettant pas la 

pénétration des racines par contre les régosols reposent sur les roches meubles, faibles ou 

assez morcelées. Pour permettre une facile pénétration des racines par cette classe, il sera 

utile de procéder. 

 Sols peu évolués : sont pauvres en matière organique mais sont plus ou moins 

colonisés par la végétation. Les boisements sont possibles sur ce type de sol. Les sols, 

d’apport colluvial modaux sont davantage voués à l’agriculture qu’aux forêts s’ils sont trop 

caillouteux ou sur une forte pente, ce sont généralement de bons sols profonds. 

2.1.3.2. Vertisols 

      Du fait des fentes de retrait après le lessivage du et compacité des horizons ces sols ne 

conviennent pas à la forêt mais constituent de très bonnes terres à céréales si la pente est 

moins excessive et la pluviométrie suffisante, notons aussi qu’ils des sols profonds ou les 

racines ne trouvent pas de difficultés pour leur développement. 

2.1.3.3. Sols calcimagnisiques 

    Rendzines : ils se comportent comme des sols secs avec horizon peu épais, ils donnent 

des terres de cultures convenables, surtout si le sol est humifère avec une structure grenue. 

Les rendzines sont en général défavorables à la régénération si le sol est superficiel et trop 

filtrant. 

2.1.3.4. Sols bruns calcaires 

     Quad le sol contient beaucoup de calcaire actif, les essences calcifuges sont à éliminer. 

Seules les espèces tolérantes ou calcicoles peuvent se développer un sol calcaire. 

2.1.3.5. Sols à sesquioxyde de fer  

Ils sont en général assez compacts. Les pluies s’infiltrent plus moins mal, ces terrains sont 

mieux réservés à l’agriculture si la pente est moins accentuée. 

2.1.4. Morphologie du bassin versant  

2.1.4.1. Hypsométrie 

     Elle consiste à joindre les points d’égales altitudes; dans le cas où elles sont rapprochées 

la pente est raide et lorsqu’elles sont éloignées, la pente est faible et le terrain a un aspect 

plat. 
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        A partir du MNT30 de notre zone d’étude, traité par le logiciel ArcGIS10.2 nous 

avons élaboré une carte hypsométrique avec des tranches d’altitude de 50 m, et ce pour 

faire bien ressortir les surfaces correspondantes et avoir une idée sur le degré de pente pour 

chaque tranche. 
 

Il en ressort: 
 

 Une altitude moyenne de la zone d’étude de 381.7m.381.7 m 

 Une partie à faible pente qui correspond aux plaines de la commune de Sidi 

Mhamed Benali.  

 

Figure 2 : Hypsométrie de la zone d’étude 

2.1.4.2. Pentes  

     Dans le cadre de notre étude, quatre classes de pentes ont été retenues (<5-  5 à 15% - 

15 à 30%  et > 30%). 

         Les résultats de calculs des superficies réparties par classes de pentes, figurent dans 

le tableau ci-dessous 
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Tableau 01: Répartition des superficies de classes des pentes  

 

 

Classe 

 
Classe des pentes 

(%) 

Superficie 

Km² % 

1 < 5 92,5 30,6 

2 5 - 15 185,8 61,5 

3 15-30 23,4 7,8 

4 + 30 0,2 0,1 

 Total 302,0 100,0 

 

 Les deux premières classes  <5 et (5à15%) sont prépondérantes couvrant (30.6% 

,61.5 %) de la superficie totale étudiée ce sont des terrains fortement accidentés 

ayant subi une forte érosion et dégradation.  .  

 

 Les deux dernières classes (15 à 30 %) et plus de  +30 %, En superficie elles sont 

relativement faible en comparaison aux autres classes (7.8% ,0.1 %). La plus part 

des terres sont nues, abandonnées si elles ne sont pas exploitées en céréales 

           Ainsi une grande partie de la superficie totale est favorable au développement de 

l’agriculture de montagne (terrains privés) et Reboisement de protection (domaine 

publique de l’Etat). 

 

Figure 03: Carte des classe de des pentes de la zone d’étude  (Source : travail originale, 2017). 
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2.1.4.3. Exposition  

    L’exposition est un facteur du milieu non moins important puisqu’il permet de 

déterminer l’humidité relative et le taux de l’évapotranspiration. 

De ce fait, les versants expositions Nord et ouest, généralement bien arrosés, sont plus 

humides que les versants sud et sud Est où les faibles précipitations et leur irrégularité 

augmentent l’évapotranspiration. 

 Dans l’ensemble du périmètre étudié, l’exposition sont variables et sont fonction de la 

configuration topographique du terrain. Notre zone d’étude présente différentes expositions 

Tableau  02: Répartition de différentes expositions de la zone d’étude  

Orientations 

Surface 

Km² % 

Nord  41,6 13,8 

Nord-est 30,3 10,0 

Est 27,6 9,1 

Sud-est 41,7 13,8 

Sud 42,2 14,0 

Sud-ouest 33,8 11,2 

Ouest 37,5 12,4 

Nord-ouest 47,2 15,6 

Total 302,0 100,0 

 
Figure 04: Carte d’exposition de la zone d’étude  (Source : travail originale, 2017). 
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2.1.4.4. Réseau hydrographique 

     Le réseau hydrologique se définit comme l’ensemble des cours d’eau naturels ou 

artificiels ou temporaires qui participent à l’écoulement des eaux superficielles.  

 

Figure 5 : Réseau hydrographique de la zone d’étude 

Le réseau hydrographique constitue le résultat des eaux de ruissellement sur le substrat 

géologique (Eque, 1984). 

Au moyen du logiciel ArcGIS 10.2 et à l’aide de la commande spatial analyst tools ensuite 

hydrology, nous avons extrait le réseau hydrographique du bassin versant de l’Oued 

Kramis. Ce bassin versant est divisé en 18 sous bassins versants et un réseau 

hydrographique peut aller à un ordre de 5 (figure 5). 

2.1.5. L’Occupation de sol du bassin versant 

     Dans la planification d’un projet de conservation des sols, la couverture végétale doit 

être placée au premier rang parmi les moyens pour lutter contre la dégradation des sols. 

D’après Kouri (1993), le couvert végétal est un facteur conditionnel important des 

phénomènes de dégradation, son influence se marque surtout à travers le degré de 

couverture du sol. 
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2.2.5.1. Les forêts 

    Ce sont des formations végétales composées principalement d’arbres, mais aussi 

d’arbustes et d’arbrisseaux (Clemen, 1990). 

La zone d’étude ne dépose pas des forêts de grandes superficie les seules qui existent sont 

mentionnées dans le tableau 03. 

Tableau 03 : La superficie des forêts existe 

Formation forestière  Superficie (ha) 

Forêt Chabaibia 

Forêt domanial  

Araar  

Sidi Saïd 

Zekri 

Saha 

298 

220 

60 

120 

40 

80 

Sidi Khalfi 60 

En effet ces forêts sont constamment soumises aux risques d’incendies à cause des 

pressions exercées par les populations riveraines, cet état de dégradation est accentué par 

les attaques d’insectes xylophages (chenille processionnaire). 

2.1.5.2. L’arboriculture et viticultures 

     Les arbres fruitiers couvert 88 ha soit 39% de la superficie totale de la zone d’étude, les 

principales espèces soit les amandiers et l’olivier, la vigne occupe une faible superficie de 

l’ordre de 145 ha soit 0.05%, elle est localisé sur : Grainiya 24ha, Tamdjet 21ha et Oued 

Missoum 100ha. 

2.1.5.3. La céréaliculture 

    Ces cultures riveraines de base  sont pratiquées par un nombre important d’agriculteurs, 

elles occupent les plaines, les collines, et les piémonts. 

C’est dans la zone d’étude la céréaliculture couvre plus de 40% de superficie totale, ou on 

introduit (le blé, l’orge et l’avoine). 
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2.1.5.4. Cultures maraichères 

     Les cultures maraichères occupent les secteurs irriguées situés dans les vallées à 

proximité de l’Oued Kramis. Les espèces maraichères saisonnières exigeant des travaux de 

sarclage (pomme de terre, tomate, oignons,…etc.) sont pratiquées en rotation avec la 

jachère.       

2.1.5.5. Reboisement 

    Les escarpements marneux sont reboisés en Pinu shalpensis, Eucalyptus 

gamphocephala, acacia cyanophylla et Atriplex halimus recevant annuellement  231 mm 

de pluies par an. Ces reboisements se divisent en deux types; l’un des sols stériles des 

terrasses qui est clair et l’autre sur des sols n’ayant subi aucun type d’aménagement. Ce 

dernier apparaît dense.  

2.1.5.6. Steppe 

     Cette formation est représenté dans bassin versant de barrage Kramis sur des sols 

superficiels sur marnes  vert-clair  recevant moins de 230 mm de pluies par an. Le cortège 

floristique est dominé par Artemesia herba alba et Artemesia compestris et comporte 

également Stipa tenacissima, Poabulbosa et Ziziphus lotus. Ces espèces sont broutées par 

le bétail. Le recouvrement du sol est nul et la hauteur ne dépasse pas 50 cm.  

2.1.6. Etude climatique 

      Selon Legrain (2002), le climat est l’ensemble des phénomènes météorologiques 

(température, pression, vent, précipitation…etc.) qui caractérisent l’état de l’atmosphère et 

son évolution en un lieu donné, ces phénomènes sont en interaction d’où leur rôle 

primordial dans le comportement hydrologique des cours d’eau, l’abondance de la 

végétation…etc. Le climat joue un rôle essentiel dans la répartition et le développement 

des plantes et la nature du sol. 

2.2.6.1. Les stations pluviométriques  

    Les données pluviométriques ont été obtenues à partir du site Web (2016) : 

http://tn.freemeteo.com/letemps/historique/historique-uotidien/?gid=2492205&date=2015-

05-06&station=13004&language=french&country=algeria. Pour les onze stations (Sidi 

Mhamed Benali, Taougrite, Mediouna, Ain Merane, Khadra, Dahra, Achaacha, Negmaria, 

Beni Zentis, El Guettar et Mazouna). Ces stations pluviométriques sont réparties 

spatialement comme suit : deux stations localisées à l’intérieur et neuf autres sont situées 

hors de la zone d’étude. Leurs caractéristiques sont données dans le tableau 04. 
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Pour analyser les différents facteurs climatiques influençant la dynamique spatiotemporelle 

du couvert végétal sur le bassin versant de l’Oued Kramis à savoir les températures 

mensuelles (max, min, moyenne et aptitude), le cumul pluviométrique mensuel, nous 

avons choisis celle de Sidi Mhamed Benali comme étant une station de référence de notre 

région d’étude. Le choix de cette station a été reposé sur les constations suivantes : 

Les précipitations moyennes annuelles de cette station (398.2 mm/an) sont proches aux 

précipitations moyennes annuelles de l’ensemble des stations de la zone d’étude (375.5 

mm/an avec un écart de 22.7 mm) ainsi que sa localisation au sein de la zone d’étude. 

 

Tableau 04 : Caractéristiques des stations pluviométriques de la zone d’étude 

N° Nom de station Projection 

UTM WGS84 

P 

(mm) 

T (°C) Alt. 

(m) 

Locali. Nb. Année  

X (dd) Y (dd) 

1 Sidi Mhamed Benali 0.87 36.18 398.2 20.3 496 (+) 11 ans  

2 Taougrite 0.94 36.30 313.0 20.1 547 (-) 11 ans  

3 Mediouna 0.75 36.15 348.0 19.8 488 (+) 11 ans  

4 Ain Merane 0.97 36.19 335.0 20.2 436 (-) 11 ans  

5 Khadra 0.55 36.24 356.0 19.9 153 (-) 11 ans  

6 Dahra 0.79 36.29 350.0 19.4 501 (-) 11 ans  

7 Achaacha 0.65 36.27 366.0 18.8 219 (-) 11 ans  

8 Negmaria 0.64 36.19 394.0 20.5 132 (-) 11 ans  

9 Beni Zentis 0.67 36.10 420.0 19.9 475 (-) 11 ans  

10 El Guettar 0.82 36.09 430.0 21.3 485 (-) 11 ans  

11 Mazouna 0.90 36.11 421.0 22.2 375 (-) 11 ans  

(+) au sein de la zone d’étude, (-) hors zone d’étude 
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 2. 1.6.2. La température  

     Le facteur thermique a une influence capitale sur les comportements des organismes par 

le contrôle qu’il exerce sur l’ensemble des processus vitaux. La croissance, l’activité 

végétative et la production sont étroitement dépendantes de la température. 

Les espèces végétales sont plus sensibles aux températures minimales de la saison froide et 

aux températures maximales de la saison chaude et par conséquent à l’amplitude de leurs 

oscillations. 

Tableau 05: Températures moyennes mensuelles (2004 -2015) de la zone d’étude 

Mois Jan. Fév. Mars Avr. Mai Juin Juil. Aout Sept Oct. Nov. Déc. Moy 

M 7.1 7.4 8.6 11.8 14.7 18.8 22.8 23.5 20.3 16 11.1 7.9 14.7 

M 16.2 16.9 19.1 23.9 28.3 33.4 38.1 38.3 33.1 27.6 20.4 16.4 26.9 

Moy 11.7 12.1 13.9 17.9 21.5 26.1 30.3 30.6 26.7 21.8 15.7 12.1 20.8 

Apt 9.1 9.5 10.5 12.1 13.5 14.6 15.3 14.8 12.8 11.6 9.3 9.0 11.7 

Apt.*: écart entre la valeur maximale et minimale 

Tel que : 

M : Température moyenne mensuelle des maxima. 

m : Température moyenne mensuelle des minima. 

(M+m)/2 : Température moyenne mensuelle des moyennes. 

L’analyse de l’indice des écarts thermiques mensuels (M-m) met en relief des températures 

assez importantes pendant une période allant d’Avril à Septembre. Cet indice moyen 

interannuel, appelé également l’indice de continentalité, permet de préciser l’influence 

maritime ou au contraire continentale d’une région donnée.  

Debrach (1953) définit quatre types de climats: 

Climat insulaire: M-m < 15°C. 

Climatlittoral : 15°C < M-m < 25°C. 

Climat semi-continental : 25°C < M-m < 35°C. 

Climat continental : M-m > 35°C. 

L’indice de continentalité permet de situer notre zone dans un climat insulaire. 
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Figure 6 : Répartition spatiale des températures moyennes annuelles sur la zone d’étude 

Les températures moyennes mensuelles de chaque station (11 stations, figure 5) ont été 

estimées. D’après la figure 6 on remarque que le secteur Sud-Est a enregistré des valeurs 

relativement élevées par rapport a celui situé au Nord-Ouest de la zone d’étude. Cette 

variabilité spatiale des températures peut être liée aux conditions géographiques 

(l’éloignement à la mer, exposition des reliefs, exposition aux vents, durée 

d’ensoleillements…etc.).  

L’extrapolation des températures mensuelles de 11 stations métrologiques sur l’ensemble du 

bassin versant de l’Oued Kramis a été réalisée au moyen de l’ArcGIS 10.2, en utilisant 

l’outil Geostatistical analysis Kriging/Cokriging. Le résultat obtenu a été figuré dans la 

carte des températures moyennes annuelles (figure 6). 

2.1.6.3. Les précipitations 

      Les précipitations sont définies comme : «formes variées sous lesquelles l’eau solide 

ou liquide contenue dans l’atmosphère se dépose à la surface du globe (pluie, brouillard, 

neige, grêle, rosée» (Legrain, 2002). 

Tableau 06: Données climatiques (2004-2015) de la station de Sidi Mhamed Benali  

Mois Jan. Fév. Mars Avr. Mai Juin Juil. Aout Sept Oct. Nov. Déc. Moy. 

P (mm) 36,1 85,0 53,4 42,0 27,3 8,2 2,2 4,6 17,9 27,6 58,9 34,9 398,2 
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Figure 7: Précipitations moyennes mensuelles (2004 - 2015) 

Les cumules pluviométrique mensuels de la station de Sidi Mhamed Benali ont été estimé.  

D’après la figure ci-dessus, on déduit que le mois de Février est le mois le plus humide avec 

un cumul pluviométrique mensuel moyen de 85.0 mm, alors que la valeur minimale du 

cumule pluviométrique mensuel moyen a été enregistré au cours du mois de Juillet 2.2 mm. 

 

Figure 8: Répartition spatiale des précipitations moyennes annuelles sur la zone d’étude 

L’extrapolation des précipitations de onze stations sur l’ensemble de la zone d’étude a été 

réalisée au moyen de l’ArcGIS 10.2, en utilisant l’outil Geostatistical analysis 

Kriging/Cokriging. Le résultat obtenu a été figuré dans la carte des                      

précipitations (figure 8). On note que les valeurs maximales de précipitations ont été 

0,0

20,0

40,0

60,0

80,0

100,0

36,1 

85,0 

53,4 

42,0 

27,3 

8,2 
2,2 4,6 

17,9 

27,6 

58,9 

34,9 

P
 (

m
m

) 

Les mois de l'année 

P  (mm)



Chapitre I                                     Etude des caractères physiques du milieu            

16 

enregistrées au niveau des stations de Beni Zentis, El Guettar et Mazouna (secteur Sud) 

avec des valeurs dépassant 420 mm/an, alors que celles minimales ont été observées au 

secteur Nord de la zone d’étude  comme par exemple les stations de Taougrite et Dahra avec 

des valeurs annuelles ne dépassant pas 350mm. 

2.1.6.4. Synthèse bioclimatique 

2.1.6.4.1. Fiabilité des données climatiques utilisées (précipitations et températures)  

     Avant d’entamer l’étude de la synthèse bioclimatique sur notre région d’étude au 

moyen de deux facteurs climatiques (températures et précipitations), il est très intéressant 

tout d’abord de vérifier la fiabilité de leurs données observées durant 11 ans pour les 11 

stations météorologiques de la zone d’étude.  

Après l'application et le teste de différentes techniques de prédiction géospatiale au moyen 

du logiciel de l’ArcGIS 10.2, la méthode Ordinary Kriging/Cokriging a été choisi pour 

interpoler soit les valeurs des précipitations ou bien celles des températures moyennes 

mensuelles sur l’ensemble de la zone d’étude. Cette méthode a donné de meilleurs résultats 

de la validation croisée et de la racine carrée de la moyenne des erreurs (RMS). 

Pour toutes les stations météorologiques, la validation croisée compare les valeurs 

mesurées et prédites (températures et précipitations). Pour estimer l'erreur normalisée, les 

valeurs mesurées sont soustraites des valeurs prédites et ensuite divisés par les erreurs 

standards (figure 06 et 07) 

En générale, le meilleur modèle est celui qui a la moyenne la plus proche de zéro et la plus 

petite erreur de prédiction de racine carrée moyenne (RMS). Si les erreurs de prédiction ne 

sont pas biaisées, l'erreur de prédiction moyenne devrait être proche de zéro, mais nous 

devons toujours avoir à l'esprit que cette valeur dépend de l'échelle des données utilisées 

(Kouli et al., 2009). 

La synthèse bioclimatique est une étape indispensable à tout projet relatif à 

l’environnement. Elle s’est faite à partir des travaux d’Emberger (1930, 1955); Bagnouls et 

Gaussen (1953); Thornthwaite (1946) et Sauvage (1963), pour ne citer que ces auteurs. 
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2.1.6.4.2. Le quotient pluviothermique et les étages bioclimatiques d’Emberger  

    L’emploi du quotient pluviothermique (Q2) est spécifique au climat méditerranéen. Il a 

été utilisé avec succès en Afrique du Nord et en France méditerranéenne. En effet, ce 

quotient permet d’apprécier l’aridité des régions méditerranéennes. Les valeurs du Q2 étant 

d’autant plus basses quand le climat est plus sec. Cet indice est calculé par la formule de 

Sauvage (1963): 

                                 Q2 = 1000. P/ (M-m) [(M+m)/2] 

Où: P: précipitations moyennes annuelles (mm). 

M: température moyenne des maxima du mois le plus chaud (°K). 

m : température moyenne des minima du mois le plus froid (°K). 

Cet auteur a mis au point un zonage du bioclimat méditerranéen du plus sec vers le plus 

humide en combinant les données climatologiques et celles de la végétation. On distingue 

plus souvent les étages bioclimatiques : saharien, aride, semi-aride, subhumide et humide. 

Chaque étage comprend une stratification verticale. 

Ce coefficient a été modifié par Stewart (1969), la formule obtenue est la suivante : 

                                 Q2= 3,43. P/ (M-m) 

Q2 : Le quotient pluviométrique d’Emberger ; 

P : Pluviométrie annuelle en (mm) ; 

M : Moyenne des maxima du mois le plus chaud en (°C) ; 

m : Moyennes des minima du mois le plus froid en (°C). 

Tableau 07 : L’indice bioclimatique d’Emberger,L. (l’après Stewart, 1969) 

  Station P (mm) M °K m °K Q2 

Sidi Mhamed Benali  398,2 311,3 280,1 43,2 

Pour notre cas : 

En se réfèrent au Climagramme pluviométrique d’Emberger, la station de Sidi Mhamed 

Benali, avec Q2= 43,2 et m = 07,1°C. La valeur de Q2 portée sur le climagramme en tenant 

compte de m, classe la station de Sidi MhamedBenalide la zone d’étude dans l’étage 

bioclimatique semi-aride à hiver chaud. 
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2.1.6.4.3. L’indice d’aridité climatique de de martonne (1927) 

    En se basant sur le régime de précipitations moyennes interannuelles P (mm) et de 

températures moyennes interannuelles T (°C), l’indice d’aridité est calculé par la formule 

suivante: 

                                            I= P/ (10+T) 

Grille d’interprétation 

7,5 < I < 10 climat steppique. 

10 < I < 30 climat semi-aride. 

30 < I < 50 climat tempéré. 

Tableau 08 :L’indice de De Martonne 

Stations P (mm) P (mm) T (°C) T+ 10 (°C) I 

SidiMhamed Benali 398.2 20.8 30.8 12.9 

D’après le tableau 08, la zone d’étude est caractérisée par un climat semi-aride. 

2.1.6.4.4. Le diagramme Ombrothermique de Bagnouls et Gaussen (1953) 

     Les monts Ouest du bassin versant de Côtier algérois ont un climat de type 

méditerranéen semi-aride caractérisé par une sécheresse estivale prononcée. Selon 

Bagnouls et Gaussen (1953), une période sèche est définie comme étant celle durant 

laquelle la moyenne des précipitations (en mm) est inférieure au double de la moyenne des 

températures (en °C). 
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Figure 9 : Diagramme Ombrothermique (station de Sidi M’hamed Benali : 2004-2015) 

Le diagramme Ombrothermique montre que, la zone d’étude est caractérisée par une 

période sèche s’étalant sur six (6) mois : Mai, Juin, Juillet, Aout, Septembre et Octobre. 

Le climat du bassin versant de l’Oued Kramis est de type semi-aride, caractérisé dans sa 

majeure partie par une saison sèche et une saison humide marquée par des faibles 

précipitations. Ce climat  est influencé à la fois par l’altitude qui varie entre 756 m et 63 m 

et par son ouverture sur la mer, cette dernière  assure aussi bien l’humidification que la 

modération des températures. 
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3.1. Définitions 

La Télédétection est définie comme l’ensemble des connaissances et des techniques 

utilisées pour déterminer des caractéristiques physiques et biologiques de l’objet terrestre. 

Elle englobe tout le processus qui consiste à capter et enregistrer l’énergie d’un 

rayonnement électromagnétique émis ou réfléchi par une cible terrestre, à traiter et à 

analyser l’information, pour ensuite mettre en application cette information (Benhadj, 

2008; Alhaskeer, 2012). Le traitement et l’analyse des informations véhiculées par le 

rayonnement enregistré permettent d’accéder à certaines propriétés de cette cible: 

géométriques (position, forme et dimensions), optiques (réflexion, transmission, 

absorption, … etc.) et physicochimiques (température, teneur en eau, chlorophylle foliaire, 

phytomasse, matière organique du sol,…) (Soudani, 2005). 

Elle suppose donc l’existence d’une source d’énergie électromagnétique, d’une cible et 

d’un capteur. La source peut être passive (soleil) ou active (source artificielle= satellite): 

3.2. Utilité de la télédétection 

D'un point de vue application, et surtout pour l'observation de la terre, la Télédétection 

est un outil de collecte des données sous format raster (image). Ces images représentent un 

enregistrement objectif du spectre qui concerne les propriétés physiques et la composition 

chimique des matériaux de la surface de la terre (Liu et Philippa, 2009). Le traitement 

d'image devient ainsi un outil indispensable pour l'extraction des informations thématiques 

et/ou quantitatives de l'image. Pour une analyse plus complète, les images doivent être 

analysées en conjonction avec d'autres données complémentaires, telles que les 

thématiques existants ; les cartes de la topographie, la géomorphologie, la géologie et 

l'utilisation des terres, ou avec géochimiques et géophysiques, données d'enquête ou de 

données de terrain, là où un Système d'Information Géographique (SIG) entre en jeu. Les 

SIG contient des outils très sophistiqués pour la gestion, l'affichage et l'analyse de tous les 

types d'l'information à référence spatiale (Longley et al., 2009). 

3.3. Principe de la télédétection 

Le principe de la Télédétection est similaire à celui de la vision de l’homme. La 

Télédétection est le résultat d’interaction de trois éléments fondamentaux : 

 La cible qui est l’élément ou la portion de la surface terrestre observée par le 

satellite; 
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 La source d’énergie qui éclaire la cible en émettant une onde électromagnétique; 

 Le capteur ou plateforme de Télédétection   mesure l’énergie réfléchie par la cible. 

 

Source:Soudani, (2005) 

Figure 10 :   Principe de la Télédétection 

3.4. Différentes étapes de la télédétection 

 Une source d’énergie ou d’illumination (A) : En Télédétection dite passive, le soleil 

constitue la principale source d’énergie. En Télédétection dite active, la source est 

fabriquée par l’homme. 

 Interactions entre le rayonnement et l’atmosphère tout au long du trajet source-cible 

et cible-capteur (B). 

 Interactions avec la cible (C) : Ces interactions sont de trois types : la transmission, 

la réflexion et l’absorption. L’émission est à considérer comme un phénomène à part. 

 Enregistrement du signal par le capteur (D) : Le capteur enregistre le signal reçu par 

la cible. 

 Transmission, Réception, et Traitement (E) : Le satellite transmet les signaux vers 

des stations de réception au sol ou à des satellites relais. Au niveau de ces stations, les 

informations sont décodées et enregistrées sous forme d’images ou de photographies. 
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 Traitements, analyses, interprétation et applications (F et G) : Les traitements se 

basent sur des théories et techniques souvent complexes et servent à extraire les 

informations utiles. Ces informations sont ensuite utilisées pour caractériser la cible étudiée. 

3.5. Bases physiques de la télédétection 

3.5.1. Rayonnement électromagnétique 

 

Source:Soudani (2005) 

Figure 11 : Caractéristiques d’une onde électromagnétique monochromatique 

λ : Longueur d’onde ou distance entre deux points exprimée en µm=10
3
ηm = 10

-6
 m 

f : Fréquence ou nombre d’oscillations par unité de temps (s
-1

 ou Hz-Hertz). 

T: Temps nécessaire pour réaliser une oscillation : T = 1/ f. 

Relation fondamentale : λ = c/ f 

c: vitesse de la lumière dans le vide =3 10
8
 ms

-1
 

3.5.2. Interactions du rayonnement électromagnétique 

Tout rayonnement (figure 12), affectant une matière donnée, est absorbé, réfléchi ou 

transmis de façon à répondre à la relation : α+ τ + ρ = I. 
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Source : Abdelbaki (2012) 

Figure 12 : Interactions du rayonnement électromagnétique avec la une cible «absorption, réflexion, 

transmission» 

Où : 

α = Absorption ; 

τ = Transmission ; 

ρ = Réflexion. 

3.5.3. Signatures spectrales des principales surfaces naturelles 

En fonction de la nature et des caractéristiques intrinsèques des objets et des surfaces, le 

rayonnement incident interagira avec la cible selon l'une ou l'autre des propriétés citées 

précédemment, ou de manière générale selon une combinaison de ces propriétés.  

Chaque surface possède ainsi une signature spectrale - quantité d'énergie émise ou 

réfléchie en fonction de la longueur d'onde - qui lui est propre et qui permettra son 

identification sur les images satellitaires. La figure ci-dessous présente la signature 

spectrale des principales surfaces naturelles. 
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Source: Soudani (2005) 

Figure 13 : Spectre du rayonnement électromagnétique solaire 

Contrairement à l'œil humain qui n’est capable de capter le rayonnement que dans une 

fenêtre très étroite du spectre électromagnétique (0,4μm et 0,7μm), les capteurs satellitaires 

utilisent une fraction beaucoup plus étendue (fenêtres spectrales) : 

Le visible 0.4 -0.7 μm 

Le proche infrarouge 0.7 -1.5 μm 

L’infrarouge moyen 1.5 – 3 μm 

L’infrarouge thermique 3 -15 μm 

Les micro-ondes ou hyperfréquences 1 mm – 1 m. 

 

Source: Soudani (2005) 

Figure 14: Signatures spectrales des surfaces naturelles dans le domaine du visible, du proche infrarouge 

et de l'infrarouge moyen (UVED, 2008) 
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3.5.3.1. La végétation 

Comme nous pouvons le constater sur la figure 05, et selon  Moquet (2003), en générale 

possède une réflectance : 

Très faible dans le rouge (~660nm) et le bleu (~450nm) ; 

Faible dans le vert (~546nm) ; 

Élevée dans le proche infrarouge (0,7-1 μm). 

Ces valeurs peuvent varier en fonction de la teneur en eau de la plante, de la structure 

des feuilles, de leur densité, ainsi que de leur âge (Guyot, 1984). 

L'identification et le suivi des couverts végétaux repose sur la réponse spectrale des sur 

faces dans les différentes longueurs d'onde et donc sur la notion de signature spectrale. 

 

Source: Soudani (2005)  

Figure 15 : Comportement spectrale de la végétation dans le domaine du visible et l’infrarouge Les 

longueurs d'onde bleue et rouge sont absorbées par la chlorophylle. Les vertes sont très faiblement réfléchies 

par la feuille. Le rayonnement infrarouge (IR), lui, est fortement réfléchi par le parenchyme. 

3.5.3.2. Le sol 

En ce qui concerne la signature spectrale des sols, on note un accroissement régulier de 

la réluctance au fur et à mesure qu'on se déplace vers les grandes longueurs d'onde. Les 

discontinuités que l'on observe dans le proche infrarouge et l'infrarouge moyen sont dues 

aux bandes d'absorption de l'eau. L'étude des propriétés spectrales des sols est toutefois 

particulièrement complexe car elle doit tenir compte de la nature hétérogène du sol qui 

contient à la fois des matières minérales et organiques, mais aussi une composante liquide ; 

tous ces éléments vont influencer la réflexion du rayonnement (Toumi,2013) 

V 

B 
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3.5.3.3. L'eau 

Elle a une réflectance très faible dans toutes les longueurs d'onde, elle absorbe 

cependant un peu moins les ondes les plus courtes, d'où sa couleur bleue. Sa signature 

spectrale dépend à la fois des molécules qui la constituent, mais aussi des éléments dissous 

ou en suspension dans la colonne d'eau, comme les organismes phytoplanctoniques, les 

sédiments ou les substances jaunes (Gower et al., 1988). 

3.6. Image numérique de télédétection et sa structure 

Une image de photographie est toute forme de représentation en deux dimensions. 

L’image numérique est divisée en petits morceaux de taille et de forme égale, que nous 

nommons pixels. La luminosité de chaque pixel est représentée par une valeur numérique. 

L'ordinateur affiche chaque valeur numérique comme un niveau de luminosité (niveau de 

gris). L’objectif est de représenter une portion de l’espace géographique. Dans son 

principe, l’élément de l’image numérique exprime une grandeur physique, la luminance 

exprimant l’énergie réfléchie ou émise. L’image ne contient qu’une mesure relative de 

luminance exprimée en ton de gris (un nombre compris entre 0 et 255). A ce contenu de 

luminance s’ajoute celui de son positionnement dans la dimension                              

spatiale (Gower et al., 1988). 

 

Figure 16 : Image numérique de Télédétection et sa structure 

3.6.1. Caractéristiques d’un capteur de télédétection 

3.6.1.1. Résolution spectrale 

Elle correspond aux bandes de longueurs d’onde auxquelles les capteurs sont sensibles. 

3.6.1.2. Résolution spatiale 

Elle correspond à la surface élémentaire d’échantillonnages observés instantanément par 

le capteur satellitaire. Cette surface correspond au pixel (Picture element). Cette résolution 
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est 20 m * 20 m pour le satellite SPOT, 30 m * 30 m pour le satellite Landsat Thematic 

Mapper, 1000 m * 1000 m pour NOAA et AVHRR, etc. 

3.6.1.3. Résolution temporelle ou répétitivité 

Elle correspond à la période entre deux acquisitions de la même scène. Cette résolution 

ne dépend pas du capteur mais de l’orbite et du mode de manœuvre du satellite. Notons 

que le satellite SPOT offre la possibilité de viser un site sur commande permettant ainsi 

d’assurer une excellente résolution temporelle. Sans manœuvre, la résolution temporelle de 

SPOT est de 26 jours, 16 jours pour LANDSAT TM et 14.5 jours pour NOAA-AVHRR. 

3.6.1.4. Résolution radiométrique 

Elle correspond à la capacité d’un système d’acquisition à distinguer entre deux niveaux 

d’énergie voisins. Le rayonnement réfléchi par les cibles au sol et enregistré par le capteur 

est codé en format numérique binaire et l’image résultante est en niveaux de gris. Pour un 

codage en 8 bits, le niveau de gris correspondant au rayonnement réfléchi varie entre 0 et 

255 (soit 256 niveaux de gris = 28). En 16 bits, le niveau de gris varie entre 0 et 65535. 

Deux niveaux de rayonnement voisins peuvent être confondus lorsque le codage est sur 8 

bits alors qu’il n’est plus pour un codage sur 16 bits (Soudani, 2005). 

3.6.2. Analyse d’une image satellite 

L’étude de la dynamique du couvert végétal est axée sur la bonne représentation des 

unités principales sur une image. Leur variation hétérogène spatiale, spectrale et temporelle 

exige de les présenter de façon homogène pour mieux interpréter les objets d’une image et 

tout un processus de changement observé. Cette représentation dite « classification » est 

utilisée pour la production de cartes thématiques où elle offre une analyse plus détaillée de 

l’image. Elle peut être effectuée sur un ou plusieurs canaux d’une image pour séparer les 

divers éléments que les constituent en fonction de leurs caractéristiques de leur signature 

spectrale, en traitement numérique des images, on distingue : 

3.6.2.1. Classification non supervisée/ non dirigé 

Cette méthode consiste à classer les données d'image numérique, par traitement 

informatique basé uniquement sur les statistiques d'image sans recours à des échantillons 

d'entraînement. Elle produit un regroupement naturel des pixels de l’image que l’on nomme 

regroupement spectral ou classe (les régions de l’image ayant une même signature spectrale 

ont un type d’utilisation du sol similaire). L’analyste doit ensuite déterminer l’identité de ces 
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regroupements spectraux. Les principaux algorithmes de classification non dirigée sont : le 

regroupement par moyenne-K (K-means) et le regroupement par ISODATA(Girard, 1989). 

3.6.2.2. Classification supervisée 

Elle est utilisée pour l’identification de zones spectralement similaires d’une image. On 

identifie d’abord des sites d’entraînement dont on extrait la signature spectrale et à partir 

desquels on extrapole pour le reste de l’image. Selon Duminil (2007), ces sites 

d’entraînement servent de base pour les calculs des algorithmes de classification. 

3.6.2.3. Classification  orient objet 

      A la différence de la classification par pixel, la méthode basée sur l’approche orientée 

objet regroupe les pixels selon leur appartenance à des régions homogènes en tenant 

compte à la fois de leur caractéristiques spectrale, spatiale, morphologique, texturale, 

contextuelle, temporelle et thématique. L’objectif principal est de gommer l’effet « poivre 

et sel » présent dans la classification des méthodes traditionnelles. (Blaschke, 2009) 

Ainsi, ces groupes de pixel sont considérés comme des objets pour lesquels on peut 

accéder à leur propriété. Cette méthode est actuellement implémentée dans plusieurs 

logiciels du marché (ENVI, ERDAS, ..) mais c’est le logiciel eCognition qui propose une 

version qui se rapproche de l’interprétation humaine. (Navulur, 2007) La démarche de la 

classification sous ce logiciel se fait en deux étapes : segmentation et classification. 

 

3.7. La Cartographie 

3.7.1. Définition 

La cartographie est l’ensemble des études et des opérations, scientifiques et 

techniques, intervenant dans l’établissement des cartes ou des plans à partir de résultats 

d’observation directes ou de l’exploitation d’une documentation préexistante (LONG, 

1974). Selon CAUVIN et al. (2007) la cartographie est l’ensemble des concepts, des 

méthodes et des techniques permettant de représenter sur un plan ou son équivalent, une 

partie de la surface terrestre, avec ses caractéristiques, ses attributs que l’on peut observer 

ou extraire, et de faire apparaitre, de transmettre ou de communiquer de l’information dans 

un but précis à des individus définis au moyen de cette représentation numérique, 

graphique, visuelle appelée carte». 

Cette dernière étant définie comme une représentation géométrique, conventionnelle d’une 

partie de la surface terrestre, c'est-à-dire, une représentation en position relatives, de 
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phénomènes concrets ou abstraits. Cette représentation s’effectue sur un support conçue à 

un moment donné du temps pour un (des) but (s) précis (Cauvin et al., 2007). 

La carte exprime plus de choses que ne peut le faire un texte, elle les exprime plus 

clairement, c’est-à-dire d’une manière aisée et plus vite exploitable, elle les exprime enfin 

plus objectivement (Ozenda, 1986). 

 

3.7.2. Types de carte  

Il y a deux types des cartes: 

3.7.2.1. Carte topographique 

          Ces cartes sont un outil de référence, montrant les contours d'une sélection de 

caractéristiques naturelles et artificielles de la terre. Elle agit souvent comme un cadre pour 

d'autres informations ; on la désigne aussi par l’expression « carte de base » (Long, 1974). 

3.7.2.2. Carte thématique 

 

Désigne toute carte non exclusivement topographique représentant sur un fond 

repère topographique, des phénomènes localisables de toute nature, qualitatifs ou 

quantitatifs. Ces cartes sont un outil pour communiquer des concepts géographiques tels 

que la distribution des espèces forestières (ansari et al., 2008 in zerroug, 2012). 

3.8. La télédétection dans le domaine de l’écologie végétale avantages et inconvénients 

On faire une première évaluation de l’utilisation des images Landsat pour cartographier 

et évaluer des unités de dégradation de sols. 

3.8.1. Avantages 

La Télédétection est un moyen rapide et relativement peu coûteux pour réunir des 

informations sur les terres quand on  ne dispose d’aucune autre source de données ou  

quand les renseignements sont de médiocre qualité. Pour ces diverses raisons, elle à été 

particulièrement utile au projet d’évaluation en ce qui concerne le couvert végétal et 

l’utilisation des terres: 

 Elle permet une délimitation exacte des limites physiographiques. 

 Elle donne la seule complète semblable à une photographie de la totalité des la zone 

étudiée. Cette caractéristique facilite des déductions quant aux types et causes de 

dégradation des sols. 

 Elle donne la possibilité de faire des examens multi spectraux répétitifs, annuels ou  

saisonniers, cet aspect n’a pas été expérimenté, mais un indice à été établi dans les zones 
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tests au moyen des images fournies par satellites cet indice pourra être comparé avec les 

conditions qui se créeront à l’avenir. 

 L’interprétation des images de satellites pour l’évaluation de la dégradation des sols 

peut être  utilisée à plusieurs niveaux (du 1/5000 000 au 1/1000 000). 

3.8.2. Inconvénients 

 Tous les renseignements de télédétection utilisés pour l’évaluation de la 

dégradation des sols proviennent de l’interprétation. C’est une tâche longue et onéreuse. 

 Certaines limites d’unités importantes peuvent passer inaperçue là ou l’expression 

physiographique est peu marquée ou masquée par la végétation, comme c’est le cas dans 

les zones tropicales tests. 

 Les estimations du pourcentage de couvert végétal (mais ce sont les seules dont on 

dispose) manquent parfois de précision à la petite échelle utilisée, ou à des échelles plus 

grandes si le pourcentage de végétation est inférieur à 20%. C’est un problème faut vérifier 

sur le terrain. 

Elle demande un personnel hautement compétent et expérimenté, et une bonne 

connaissance de la région à interpréter. 
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4.1. Outils utilise  

4.1.1. Outils d’analyse  

4.1.1.1. Méthode orientée objet  

     Cette méthode est actuellement implémentée dans plusieurs logiciels de marché (ENVI, 

ERDAS, ..) mais c’est le logiciel eCognition qui propose une version qui se rapproche de 

l’interprétation humaine (Navulur, 2007) La démarche de la classification sous ce logiciel 

se fait en deux étapes : segmentation et classification.  

 Segmentation  

La première étape consiste à la segmentation de l’image. Le logiciel propose également 

plusieurs types de segmentation illustrés dans la figure ci-dessous. (cf. Documentation du 

logiciel).  

 

Figure 17 : Algorithmes de segmentation (eCognition) 
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 Classification  

Une fois définie les différents paramètres permettant de segmenter au mieux l’image, la  

- Par la suite, les objets de chaque classe peuvent être fusionnés.  

- L’affectation des objets à leurs classes respectives en définissant des seuils,  

 

 

Figure 18: Classification par pixel (a) ; classification orientée objet (b) 

4.1.1.2. Envi: (Environment for Visualizing Images) 

    ENVI fournit des outils pour la visualisation, le géoréférencement, 

les prétraitements, la classification et l’analyse des images satellitaires 

(Thomas et al, 2005.). 

Il répond à la plus part des exigences de base nécessaires pour le traitement d’une 

image  

Visualisation et traitement des données de télédétection ; 

- Traitement et analyse spéctrale de l’imagerie multispectrale et hyperspectrale ; 

- Géoréférencement des images ; 

- Classification et interprétation interactive ; 

- Analyse de la végétation à l’aide des indices de végétation (NDVI) ; 
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- Correction géometrique et radiometrique ; 

- Calibrage et correction atmosphérique ; 

- Support des formats raster et vecteur ; 

- Fournis un soutien aux données de télédétection par satellites 

WorldView-1, QuickBird, Ikonos, Cartosat, ALOS, EROS, 

Orbview, SPOT, IRS, TERRA (ASTER), Landsat, etc. 

 Images satellites utilisée 

     Dans notre étude afin de pouvoir cartographier les différentes occupations du sol nous 

avons utilisé une image satellitaire issue de Landsat 8 Operational Land Imager (OLI) et 

Thermal Infrared Sensor (TIRS). Cette image a été acquise le 26 mai 2016 dont le path 197 

et le row 35 couvrant notre zone d’intérêt. Les caractéristiques physiques des différentes 

bandes qui la constituent sont mentionnées dans le tableau 00. 

 Lancement d’ENVI 

 Ou double-cliquez l’icône d’Envi sur le bureau  

 Dans le menu principal cliquez sur File →Open image file 

 

 Cliquez sur Ouvrir 
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Cette image est constituée de 8 bandes avec les longueurs d’ondes correspondantes 

suivantes : 

Gamme de 

bandes 

(micro m) 

Localisation 

spatial 

Resolution (m) Swath 

(km) 

Application principle 

B1 : 0.45-0.52 Bleu 30x30 185 Pénétration des plans d’eau, 

cartographie des eaux territoriales 

B2 : 0.52-0.60 Vert 30x30 185 Distinction de la végétation, évaluation 

de la vigueur et identification des 

différents types de cultures 

B3 : 0.63-0.69 Rouge 30x30 185 Absorption de la chlorophylle, et 

différenciation des espèces végétales 

B4 : 0.76-0.90 Proche IR 30x30 185 Détermination des types de 

végétation et surveillance de la 

vigueur et de la biomasse, définition 

des limites des plans d’eau 

B5 : 1.55-1.75 Moyen IR 30x30 185 Indicateurs de végétation et 

d’humidité du sol utilisés pour la 

différenciation de la neige et des 

usages 

B6 : 10.4-12.5 IR therm. TM 120x120 

ETM+ 60x60 

185 Analyse des contraintes de végétation, 

distinction de l’humidité du sol et 

cartographie thermique 

B7 : 2.08-2.35 Moyen IR 30x30 185 Identification des types de roches et de 

minéraux, cartographie hydrothermale 

et mesure de 

l’humidité du sol et de la végétation 

 

Source: WU, 2003; http://landsat.gsfc.nasa.gov/images/. 

La boîte de dialogue Available Bands List affiche le nombre de couches que  

 

http://landsat.gsfc.nasa.gov/images/
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 Affichage en niveaux de gris 

 Cliquez sur la bande *_B30. 

 Choisissez le mode d’affichage Gray Scale 

 Cliquez sur le Bouton Load Band. 

 

 

 Affichage en niveaux de gris 

 Cliquez sur la bande *_B30. 

 Choisissez le mode d’affichage Gray Scale 
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 Cliquez sur le Bouton Load Band. 

 

Trois fenêtres s’ouvrent : la fenêtre principale Display, le Scroll et le Zoom. 

 

 

 



Chapitre III                                                                     Matériel et Méthode 

39 

Le carré rouge sur la fenêtre Scroll permet de délimiter la zone géographique qui 

s’affichera sur la fenêtre Display ; et le carré rouge dans la fenêtre Display permet de 

délimiter la zone géographique qui s’affichera sur la fenêtre Zoom. 

 Affichage en vraies et fausses couleurs : composition colorée 

 Validez l’option RGB dans la boîte de dialogue Available Bands List 

 Puis cliquez sur Load RGB. On obtient l’écran suivant. 

 

Une nouvelle fenêtre s’ouvre. 

 Cliquez sur File de la fenêtre Available Band List puis sur Close All Files pour 

fermer tous les fichiers ouverts. 

 Quittez complètement ENVI à partir du menu principal d’Envi en cliquant sur File → 

Exit. 

     Les méthodes de classification les plus communes peuvent être séparées en deux 

grandes catégories : les méthodes de classification supervisée et les méthodes de 

classification non supervisée           
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4.1.1.3. Classification non supervisée 

    On distingue deux méthodes de classification non supervisée sous Envi : 

 La méthode de K-Mean : Regroupement des pixels de l’image au centre de classes, 

régulièrement distribués dans l’hyperespace, les plus probables (statistiques).Elle permet 

une analyse régionale des grands types homogènes de couvertures végétales. 

 La méthode de classification non supervisée en valeurs égales (Isodata) : 

Regroupement des pixels de l’image aux centres des classes, régulièrement distribués 

dans l’hyperespace, les plus proches (distance). 

 Démarrer le logiciel Envi et chargement du fichier 

 Cliquez sur le menu Démarrer → Programme → Envi 4.5 →ENVI 

 Dans le menu fichier (File), sélectionnez  Open Image file. Sélectionner le fichier 

 Chargez l’image de la manière suivante : Bande 4 = Red, Bande 3 = Green et Bande 2 

= Blue 

 

 

 

 

Classification ‘ISO data’ 

 Dans le menu principal ENVI, cliquez sur Classification → Unsupervised → Isodata. 
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 Cliquez sur le nom de la composition colorée dans la boite de dialogue Classification 

Input file. 

 Laissez les informations par défaut puis appuyez sur OK. 

 

Une autre boite de dialogue dénommée ISODATA Paramètres apparait. 

 

 

Cliquez OK pour lancer la classification. 
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Le fichier de classification apparait dans Available Bands List dans l’option Gray Scale. 

 Sélectionnez-le et cliquez sur Load 

Affichez également la composition colorée dans une autre vue : Display 2 

 Choisissez New Display puis cliquez sur Load. 

 Disposez les deux vues côte à côte de la manière suivante. 

 

 

 

Utilisez l’outil Tools → Link → Link Displays pour déterminer la correspondance entre 

les couleurs et les classes. 

 

 



Chapitre III                                                                     Matériel et Méthode 

43 

 Dans la boite de Link Displays mettez tous les displays sur Yes et Dynamic overlay 

sur On. 

 

Affectez ensuite des noms aux classes. 

 Dans la fenêtre montrant l’image classée, cliquez sur Tools → Color mapping → 

Class Color Mapping. 

 

La boite de dialogue Class Color Mapping apparaît. 

Une fois, l’affectation est terminée, cliquez Options → Save changes pour valider. 

 Combinaison des classes 

 Dans le menu principal ENVI Classification, cliquez sur Post Classification 

→ Combine classes. 
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 La boite de dialogue Combine Classes Input File s’ouvre et choisissez le fichier 

cliquez OK 

 

Une autre boite de dialogue (Combine Classes Paramètres) s’ouvre. 

 Sélectionnez ‘Eau’ dans Select Input Class et Select Output Class, et confirmez par 

Add Combination. Faites pareil pour toutes les autres class dans Select Input Class. 
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Une fois terminée, cliquez sur OK. 

La boite de dialogue Combine Classes Output s’ouvre. Retirez Emply classes 

 

 Enregistrez le résultat 

Le nouveau fichier apparaît dans la boite de dialogue Available Bands List. 
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 Ouvrez-le dans un troisième Display. 

 Statistique des classes 

 Dans le menu principal ENVI Classification cliquez sur Post Classification → Class 

Statistics pour calculer les statistiques des classes. 

 

La boite de dialogue Classification Input File s’ouvre. 

 Dans la boite Statistics Input File sélectionnez de nouveau le fichier et cliquer sur OK. 

 

 Choisissez toutes les classes en cliquant sur le bouton Select All Items puis cliquez sur 

OK. 

Sélectionnez le fichier et cliquez OK. 
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4.1.1.4. Classification supervisée 

 Dans ROI Tool -> Restore ROI 

On testera les méthodes suivantes : 

 Minimum Distance ; 

 Mahalanobis Distance ; 
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 Parallélépipède; 

 Maximum likelihood (maximum de vraisemblance) 

 Minimum Distance 

 Démarrez Envi et chargez le fichier à partir de Tools → Région of Interest de la boite 

de dialogue de ROI Tool, en cliquant sur File → Restore ROIs. 

 Dans le menu principal ENVI cliquez Classification → Supervised → Minimum 

Distance. 

 

 Dans la boite de dialogue suivante sélectionnez le fichier et cliquer sur OK. 

 

Une autre boite de dialogue s’ouvre. 
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 Cliquez sur Select All Items pour sélectionner toutes les régions d’intérêt. 

 Changez Output Rule Images. Puis cliquez sur OK. 

 

 Affichez ensuite les deux images, l’image classée et la composition colorée. 

 Et utilisez l’outil Tools → Link → Link Displays pour vérifier les résultats de la 

classification. 
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 Fermez tous les fichiers et quittez ENVI. 

 Classification par Maximum Likelihood (Maximum de ressemblance) 

 Démarrez à nouveau ENVI. 

 Ouvrez et chargez le fichier  

 Chargez l’image en composition colorée RGB. 

Dans le menu Tools de Display cliquez sur Regions of Interest → ROI Tool. 

 

 

La boite de dialogue ROI Tool apparait. 

 Importez le fichier des régions  
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L’écran suivant apparait : 

 

 

 Cliquez sur OK pour charger les régions d’intérêt. 

 Cliquez sur Classification → Supervised → Maximum Likelihood dans la barre de 

menu 

 

 Sélectionnez l’image à classifier puis cliquez OK. 

 Le fichier de Roi étant déjà ouvert, dans la fenêtre Maximum Likelihood Parameters 

cliquez 

sur le bouton Select All Items pour sélectionner toutes les classes.. 
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Cliquez OK. 

Le résultat apparait dans la fenêtre Available Bands List : 

 

 

 Visualisez votre résultat dans un nouveau Display. 



Chapitre III                                                                     Matériel et Méthode 

53 

 

 Réalisation d’une carte d’occupation du sol 

- Une fois votre image classifiée, exportez le résultat : 

 Cliquez File → Save Image As… → Image File  

 Ignorez le message d’erreur qui apparait, s’il apparait 

 Choisissez TIFF/GeoTIFF comme Output File Type  

Compatible avec ArcGIS que vous utiliserez pour la mise en page de votre carte. 

 Enregistrez cette image dans votre farde Résultat et appelé la VotreNOM_Carte.tif 

 L’image a été exportée. 

Pour la mise en page de votre carte, utilisez ArcMap (ArcGis). Insérez votre carte 

dans un nouveau projet ArcMap et passez en mode layout view. Respectez les 

consignes d’édition cartographique données dans le manuel de Formation SIG. 
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4.1.1.5. Logiciel Arcgis Version 10 

Arcgis est un logiciel SIG de ESRI (Environmental Systems Research Institute), il est 

développé pour faciliter la gestion et l’analyse des données spatiales afin de répondre à une 

problématique donnée.  

- Ce logiciel a été utilisé dans ce travail pour :  

 La création l’habillage et l’édition des cartes.  

 La détection de changement entre les différentes images satellitaires. 

L’analyse de quelques données statistiques (El hadraoui, 2013). 
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5.1. Résultats et discussion 

5.1. Classification non supervisé 

5.1.1. Méthode d’Isodata 

 

Figure 19. Extraction de l’occupation du sol par la classification non supervisée algorithme Isodata 

5.1.2. Méthode de K-means 

 

Figure20. Extraction de l’occupation du sol par la classification non supervisée (K-means) 
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5.2. Classification supervisée 

5.2.1. La méthode parallélépipède 

 

Figure21. Extraction de l’occupation du sol par la classification supervisée parallélépipède 

5.2.2. La méthode likelihood 

 

Figure22. Extraction de l’occupation du sol par la classification supervisée algorithme likelihood 
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5.2.3 La méthode mahanalobis 

 

Figure 23. Extraction de l’occupation du sol par la classification supervisée mahanalobis 

 

5.2.4. La méthode minidistance  

 

Figure 24. Extraction de l’occupation du sol par la classification minidistance 
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5.3 Classification orientée objet 

 

Figure25. Extraction de l’occupation du sol par la classification orientée objet 

Tableau 09 : Extraction de l’occupation du sol par les sept méthodes de classification 

Les classes 

d’occupation du 

sol 

K-means Isodata Parallélépipède Mahanalobis Likelihood Minidistance OO 

Eau 0,8 14,3 0,2 0,6 0,5 0,6 0,5 

Céréaliculture - 14,3 3 22,5 5,8 14,1 20,5 

Forêt 40,4 14,3 0,4 10,9 5,3 3,4 5,2 

Calcaire 0,2 23 16,8 2,3 1,2 1 0,4 

Sol nu 55,7 55,2 79 42,8 60,6 59,4 61,2 

Jachère - 7,5 0,7 20,9 8,5 21,4 12,3 

Total  100 100 100 100 100 100 

        D’après le tableau 09 on remarque que les sept méthodes de classification testées (K-

means, isodata , parallélépipède, mahanalobis, mini distance, likelihood et orientée objet) 

présentent une similitude en ce qui concerne la classe du plan d’eau avec un écart de 0,5 

%. Ceci s’expliquerait par le fait que cette occupation atteint un niveau d’exactitude très 

élevé que ce soit la classification. Cette réponse spectrale nous a permis d’extraire 

aisément la surface de l’eau d’autres classes de l’occupation du sol. Ce fait est confirmé 

par d’autres travaux (Flanders et al., 2003 ; Lang et al., 2006 ; Platt et Rapoza, 2008).  
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Pour la classe des forêts une similitude a été observée pour les méthodes de classification 

likelihood, minidistance et orientée objet avec un taux d’occupation variant entre 3,4 et 5,3 

%. Tandis que la classe de céréaliculture aucune similitude n’a été remarque entre les 

différentes méthodes de classification.  

     Concernant les terres calcaires, les méthodes mahanalobis, likelihood, minidistance et 

orientée objet donnent des résultats  similaires enregistrant des valeurs variant entre 2,3 et 

0,4 %. Tandis que les autres méthodes de classification présentent des taux variables d’une 

classe à l’autre. Ce cas a été remarqué au niveau de la classe du sol nu enregistrant des taux 

varies entre 59,4 et 61,2 exceptionnellement la méthode  mahanalobis qui enregistre un 

taux de 42,8 %. Alors que la classe de jachère présente des taux nettement variables entre 

les différentes méthodes de classifications utilisées. 

       Conformément à la réalité de l’utilisation  des terrains de la zone d’étude, nous 

pouvons déduire que la meilleure méthode de classification est celle d’orientée objet. Nous 

pouvons également affirmer que, les tests de segmentation effectués sur l’extrait de 

l’image Landsat-8 OLI au moyen de logiciel eCognition ont été très utiles, permettant une 

meilleure compréhension du processus de la segmentation pour des fins cartographiques de 

l’utilisation du sol. Par ailleurs, le processus de la segmentation pour la classification 

orientée-objet via le logiciel eCognition nécessite une précision délicate entre les objets 

terrestres à cartographier. Nos résultats sont en concordance avec ceux trouvés par d’autres 

investigateurs (Pham et al., 2013 ;  Jia et al., 2013 ; Kassouk et al., 2014 ; Liu et Zhang, 

2017). Vue son importance dans le domaine de la cartographie de différentes utilisations 

des terres, cette technique a été utilisée un peu partout dans le monde 

     Notre approche a permis d’extraire les six classes avec une exactitude élevée. Le niveau 

d’exactitude le plus élevé est obtenu pour la classe « la végétation : forêt et céréaliculture » 

et le plus faible pour la classe « des terres nues ». La catégorie du plan d’eau (le lac du 

barrage) atteint un niveau d’exactitude très élevé, ce qui est dû à la réponse spectrale très 

basse de l’eau et qui est très distincte des autres classes. Ce fait est confirmé par d’autres 

travaux de traitement de l’image par l’approche d’objet (Flanders et al., 2003; Lang et al., 

2006; Platt and Rapoza, 2008). Dans la catégorie de végétation, nous avons obtenu des 

résultats adéquats, sauf pour la classe « arbres isolés ». La faible exactitude de cette classe 

s’explique par le fait qu’il est difficile d’identifier les arbres dispersés, même visuellement. 
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Laliberte et al. (2004) confirment aussi la difficulté d’identifier les arbustes de petite taille 

dans leur classification. Plusieurs études récentes ont suggéré que les données du LiDAR 

pourraient être utiles pour identifier les arbres dispersés en milieu urbain par exemple (par 

exemple Sung 2012; Zhou and Troy 2008). Les paramètres de segmentation proposés pour 

la végétation par les auteurs précédents privilégient la couleur par rapport à la forme, mais 

n’attribuent aucun poids (Laliberte et al., 2004) ou seulement un poids minime à la 

compacité (Lang et al., 2006; Platt and Rapoza, 2008). Nos résultats corroborent bien avec 

ces constats en montrant que les meilleurs niveaux d’exactitude sont obtenus dans les 

segmentations avec des valeurs de couleur de 1 et de compacité de 0. Cependant, à Hanoi, 

il n’y a pas de grands parcs régionaux avec des groupes d’arbres à taille importante. Dans 

des villes où il y a de tels types de parcs, nous recommandons de faire preuve de prudence 

lors du choix d’échelle et de compacité de segmentation, qui peut avoir un impact sur la 

taille et la forme des objets segmentés. La classe de route est également jugée difficile à 

extraire par Puissant et al. (2006), Taubenböck et al. (2006) et Caprioli and Tarantino 

(2003).  
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CONCLUSION  

       Les méthodes utilisées et notamment l’approche orientée-objet a montré un réel intérêt 

pour la caractérisation des grands types de végétation et pour la délimitation précise de 

plusieurs types de formations végétales à partir de l’image Landsat_8 OLI traitée sous 

logiciel eConigtion. Cependant tous les types de classifications utilisées (non supervisée, 

supervisée et orientée objet) dans cette étude à partir d’une l’image issue de Landsat-8 OLI 

sont reproductibles ce qui permet leurs mise en œuvre sur de vastes territoires. Les cartes 

produites au 1/500 000 présentent d’ores et déjà un intérêt certain pour mettre en évidence 

la continuité écologique entre des secteurs à enjeux pour la biodiversité dans le bassin 

versant de l’oued Kramis. En outre, ces classifications permettent de délimiter des objets, 

qui, même si leur qualification n’est pas toujours exacte au niveau des types de formations 

végétales, représentent en soi une aide significative lors de l’étape de terrain. Quelques 

préconisations seront recommandées notamment l’utilisation des images à THRS  issues 

d’autres satellites tels que, Ikonos-2, Quickbird-1, Orbview-3, Orbview-4 ou ASAL 

(Agence Spatiale Algérienne), mais avec une petite échelle de surface de l’ordre de 

dizaines de Km² afin de pouvoir cartographier l’hétérogénéité spatiale du milieu. 

   Ce travail a fait l’objet de plusieurs publications dans le domaine écologique à savoir, 

Bhaskaran et al. (2010), Achbun et al. (2013), Kassouk et al. (2014), Pham et He (2015) et 

Liu et Zheng (2017). 
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